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Introduction

Chapter 1

This document describes the features and functions of the 10GBASE-KR Ethernet targeted

reference design (LOGBASE-KR TRD). It also describes how to set up, operate, test, and modify

the design.

10GBASE-KR TRD Overview

The 10GBASE-KR TRD (Figure 1-1) targets the Kintex® UltraScale™ XCKU040-2FFVA1156C

FPGA running on the KCU1250 characterization board. It demonstrates connectivity
between the 10-Gigabit Ethernet PCS/PMA IP core (LOGBASE-KR) and the 10-Gigabit
Ethernet MAC IP core (10G MAC) and error free traffic flow on this 10-Gigabit Ethernet

channel across a backplane.
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10GBASE-KR is defined in IEEE Std 802.3-2012. It specifies the 10 Gb/s physical layer
specification using 10GBASE-R encoding over an electrical backplane.

The 10GBASE-KR TRD has two 10 Gb/s Ethernet channels; channel 0 and channel 1. Transmit
data is generated by the Traffic Generator and Monitor block. Data from one channel is
looped back to the other channel on a backplane through SMA cables as shown in

Figure 3-2, page 20. The looped-back data becomes the receive data on the other channel
and the frame length and frame check sequence (FCS) are verified by the 10-Gigabit
Ethernet MAC IP core.

A MicroBlaze™ processor subsystem monitors the 10-Gigabit Ethernet MAC IP core
statistics. It also controls the Traffic Generator and Monitor block and reports Ethernet
performance. It passes this information to the Ethernet Controller application GUI running
on the control computer via the USB-to-UART port on the KCU1250 board.

Components, Features, and Functions
The 10GBASE-KR TRD includes:

« 10-Gigabit Ethernet PCS/PMA IP core (10GBASE-KR):
o Uses GTH transceivers running at 10.3125 Gb/s line rate.

- Provides a single data rate (SDR) 10-Gigabit Ethernet Media Independent Interface
(XGMII) which connects to the 10-Gigabit Ethernet MAC IP core. The XGMII interface
runs at 156.25 MHz and the data path is 64-bits wide.

- Provides a serial interface to connect to the backplane.
- Auto-negotiation (AN) and forward error connection (FEC) is enabled.
- Is monitored and configured through status and configuration vectors.
+ 10-Gigabit Ethernet MAC IP core (10G MAC):
- Connects to the 10-Gigabit Ethernet PCS/PMA IP core using the XGMII interface.

o Provides AXI4-Stream protocol support on the user interface running at
156.25 MHz.

o Is monitored through an AXI4-Lite interface.
» Traffic Generator and Monitor:
- Generates Ethernet traffic.

- Monitors bandwidth utilization on the transmit and receive AXI4-Stream interfaces
of the 10-Gigabit Ethernet MAC IP core.

o Is configured and monitored through an AXI4-Lite interface.
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« AXI UART Lite:

- Provides the controller interface for asynchronous serial data transfer. This interface
connects to the USB-to-UART port on the KCU1250 board, and is used to
communicate with the control computer.

o Provides an AXI4-Lite interface to communicate with the MicroBlaze processor
subsystem.

* MicroBlaze processor subsystem and AXI Interconnect:

o Communicates with the 10-Gigabit Ethernet MAC IP core, Traffic Generator and
Monitor, and AXI UART Lite using the AXI4-Lite protocol.

o Drivers running on the MicroBlaze processor subsystem interpret commands
received from the Ethernet Controller application GUI running on the control
computer and convert them to AXI4-Lite transactions.

« Ethernet Controller application GUI/Driver:

- Provides a graphical user interface running on the control computer to pass user
inputs to the 10GBASE-KR TRD and to display status through the KCU1250 board
USB-to-UART port.

+ Eyescan System:
o AXI DRP bridge:

- Custom logic that allows access to DRP registers of the transceiver through any
AXI master such as the MicroBlaze processor subsystem.

o AXI block RAM controller:

- An AXIslave IP core that allows access to local block RAM by AXI master devices
such as the MicroBlaze processor subsystem and the JTAG to AXI Master IP core.

- The block RAM stores the data read from the DRP port of the transceiver.
o JTAG to AXI Master:

- An AXI Master IP core that can generate AXI transactions and drive AXI signals
internal to FPGA in the system.

- Communicates with the AXI block RAM controller via the AXI Interconnect.

- Allows the Vivado logic analyzer Tcl console running on the control computer to
interact with FPGA through the USB-to-JTAG port on the KCU1250 board.

- MicroBlaze processor subsystem:

- An AXI Master that communicates with the AXI DRP bridge and AXI block RAM
controller via the AXI Interconnect.

- Drivers running on the MicroBlaze processor subsystem implement an algorithm
to measure a statistical eye (bit error ratio (BER) versus time and voltage offset).
Data sampling points are available to read via the DRP port of the transceiver.

10GBASE-KR Ethernet TRD www.Xilinx.com Send Feedback 6
UG1058 (v2016.2) June 8, 2016 [—\/—]


http://www.xilinx.com
http://www.xilinx.com/about/feedback.html?docType=User_Guides&docId=UG1058&Title=KCU1250%2010GBASE-KR%20Ethernet%20TRD%20User%20Guide&releaseVersion=2016.2&docPage=6

i: XILINX Chapter 1: Introduction

ALL PROGRAMMABLE

Point-by-point measured data is stored in a block RAM to be burst read by the
control computer via the JTAG to AXI Master.

o AXI Interconnect:

- Allows multiple AXI masters (MicroBlaze processor subsystem and JTAG to AXI
Master) to communicate with multiple AXI slaves (AXI DRP Bridge and AXI block
RAM Controller)

Resource Utilization

Table 1-1 lists the resources used by the 10GBASE-KR TRD after synthesis has run. Place and
route can alter these numbers based on placements and routing paths, so use these
numbers as a rough estimate of resource utilization. These numbers might vary based on
the version of the 10GBASE-KR TRD and the tools used to regenerate the design.

Table 1-1: 10GBASE-KR TRD Resource Utilization

Site Type Used Available Usage (%)
CLB LUTs 29,846 242,400 12.31
CLB Registers 41,794 484,800 8.62
Block RAM Tile 42 600 6.91
Global Clock Buffers 2 240 0.83
BUFG_GT_SYNC 6 55 10.90
BUFG_GT 6 120 5.00
GTHE3_CHANNEL 2 20 10.00
GTHE3_COMMON 2 5 40.00
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Chapter 2

Setup

This chapter lists the requirements and describes how to do all preliminary setup of the
KCU1250 board, control computer, and software before bringing up the 10GBASE-KR TRD.

ﬁ IMPORTANT: Perform the procedures described in this chapter before performing the bring up
procedures described in Chapter 3, Bringing Up the Design.

Requirements

Hardware

» KCU1250 board with the Kintex® UltraScale™ XCKU040-2FFVA1156C FPGA [Ref 1]
« Two USB cables, standard-A plug to micro-B plug
« Power Supply: 100 VAC-240 VAC input, 12 VDC 5.0A output

« Backplane: Z-Pack Tinman Customer System kit from Tyco Electronics

« Two SamTec BullsEye cables from Avnet

« Four DC Blocks/AC capacitors from Aeroflex

Computer

One computer is required, and is identified as the control computer throughout this

document. It is required for running Vivado Design Suite, configuring the FPGA, and

running the Ethernet Controller application GUI to control and monitor the reference
design. It can be a laptop or desktop computer with Microsoft Windows 7 Operating
system.

Design Tools and Software

« Vivado® Design Suite 2016.2
« USB UART drivers (CP210x VCP drivers)

« Tera Term terminal emulator KCU1250 Characterization Kit
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« Java SE Runtime Environment 7
« Ethernet Controller application GUI (included with the 10GBASE-KR TRD)
« 10GBASE-KR Ethernet targeted reference design files

Download and installation instructions for each required software application and for the
10GBASE-KR Ethernet targeted reference design files are described in Preliminary Setup.

Preliminary Setup

Complete these tasks before bringing up the design described in Chapter 3, Bringing Up
the Design.

Install Vivado Design Suite

Install Vivado Design Suite 2016.2 on the control computer. Follow the installation
instructions provided in Vivado Design Suite User Guide Release Notes, Installation, and
Licensing (UG973) [Ref 2].

Download Targeted Reference Design Files

1. Download the 10GBASE-R TRD ZIP file Here:
KCU1250 Characterization Kit Documentation

2. Unzip the contents of the file to a working directory.

3. The unzipped contents will be located at
<working_dir>/kcul250_10gbasekr_trd.

The 10GBASE-KR TRD directory structure is described in Appendix A, Directory Structure.

Install the USB UART Drivers

Download the CP210x USB to UART Bridge VCP drivers (for Windows 7) from Silicon Labs.
Follow the instructions in Silicon Labs CP210x USB-to-UART Installation Guide (UG1033)
[Ref 3].
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Setup

Configure the Control Computer COM Port

The TRD uses the Tera Term Pro terminal emulator and the Ethernet Controller application

GUI to communicate between the control computer and the KCU1250 board. To configure
the control computer COM ports for this purpose:

1. Place switch SW1 to the OFF position. (SW1 in Figure 2-1).

2. Connect the KCU1250 board to the control computer and power supply as shown in
Figure 2-1.

O TIP: Figure 2-1 shows only the top edge of the KCU1250 board.

Control
Power Supply Computer
100VAC-240VAC Input

12 VDC 5.0A Output

USB cable
standard-A plug

ﬁ—to micro-B plug

Board Power
Switch SW1

To U8O

J28 12 VDC USB JTAG

J1
USB UART
=

).(NIIIX:'{.I{ 0 & ﬁ“ﬁ -

.....

.....

UG1058_c2_01_071014

Figure 2-1: Connections for Preliminary Setup

3. Power on the KCU1250 board by placing switch SW1 to the ON position. (SW1 in
Figure 2-1).
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Chapter 2:

Setup

4. Open the control computer Device Manager. In the Windows task bar, click Start, click

Control Panel, and then click Device Manager.

5. In the Device Manager window (Figure 2-2), expand Ports (COM & LPT), right-click

Silicon Labs CP210x USB to UART Bridge: Standard COM Port, and then click

Properties.
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ZZ Keyboards
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b ‘j Smart card readers

b -% Sound, video and game controllers
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m

Figure 2-2: Device Manager

]
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TIP: Make note of the COM port numbers assigned by the control computer OS in your setup to Silicon
Labs CP210x USB to UART Bridge: Standard COM Port and Silicon Labs CP210x USB to UART

Bridge: Enhanced COM Port. The Enhanced COM port number must be provided to the Tera Term Pro
terminal emulator in step 2, page 12. The Standard COM port number must be provided to the Ethernet

Controller application in step 2, page 30.
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6. In the properties window, select the Port Settings tab (Figure 2-3).

7. Set Bits per second, Data bits, Parity, Stop bits, and Flow control to the values
shown in Figure 2-3, and click OK.

F ™
Silicon Labs Dual CP210x USE to UART Bridge: Standard COM Por...l&]

General | Port Settings | Driver | Dietails | Power Managernent|

Bits per second: l1152|}|] ']
Data bits: IE v]
Parity: [None v]
Stop bits: [1 v]
Fow control: [None ']
’ Advanced... ] ’ Restore Defaults ]
[ ok || Cance

UG1058_c2_03_061714

Figure 2-3: Port Settings

8. In the Device Manager window (Figure 2-2), expand Ports (COM & LPT), right-click
Silicon Labs CP210x USB to UART Bridge: Enhanced COM Port and then click
Properties.

9. In the properties window, select the Port Settings tab and set Bits per second, Data
bits, Parity, Stop bits, and Flow control to the values shown in (Figure 2-3), and then
click OK.

Install Tera Term Pro Software

1. Follow the download and installation instructions provided in Tera Term Terminal
Emulator Installation Guide (UG1036) [Ref 4].

2. To communicate with the KCU1250 board, configure the new Tera Term connection and
serial port settings as shown in Figure 2-4. These settings must match the control
computer COM port settings shown in Figure 2-3. Select the serial COM port associated
with Silicon Labs Dual CP210x USB to UART Bridge: Enhanced COM Port.
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-
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_ Data: 8 hit - Cancel
@ 55H S5H2
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Figure 2-4: TeraTerm Pro Settings

Install Java

Download Java SE Runtime Environment 7 from Oracle and install the program on the
control computer. Follow the installation instructions provided with the software.
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Install the Ethernet Controller Application

1. Browse to <working_dir>/kcul250_1l0gbasekr_trd/software/GUI
(Figure 2-5).

@ ’ | <« work b kcul250 10gbasekr_trd » software » GUI - Search GUI yel

File Edit View Tools Help

Organize « Include in library « Share with « Burn Mew folder

-
MName Date modified

- Favorites
M Desktop £ EthemnetController-32-installer 5/1/2014 6:47 PM Application

& Downloads = §5 EthemetController-64-installer 5/1/2014 6:46 PM  Application

15 Recent Places
L My Site

. Libraries
3 Documents
J'u Music

= Pictures
[ RN "

} 2 items

UG1058_c2_05_061714

Figure 2-5: Directory Location, Ethernet Controller Installer

2. Right-click either the EthernetController-32-installer (for a 32-bit operating system)
or EthernetController-64-installer (for a 64-bit operating system) and select Run as
administrator (Figure 2-5).
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3. Click Yes in the dialog box that opens.

Setup

4. In the License Agreement display (Figure 2-6), click I Agree to continue installation.

$_ Xilinx - EthernetController Setup: License Agreement l = ﬁ,l

¥ Please review the license agreement before installing Xilinx -
4 EthernetController. If you accept all terms of the agreement, dick I Agree,

rs

PART I |

MILIMX, INC.
EMD USER LICEMSE AGREEMENT

CAREFULLY READ THIS EMD LISER. LICENSE AGREEMENT ("AGREEMENT™). BY
CLICKING THE "ACCEPT" OR "AGREE™ BUTTON, OR OTHERWISE ACCESSING,
DOWMLOADIMNG, INSTALLING OR. USIMNG THE SOFTWARE, YOU AGREE ON
BEHALF OF LICENSEE TO BE BOUND BY THIS AGREEMENT.

IF LICEMSEE DOES MOT AGREE TO ALL OF THE TERMS AND COMDITIONS QF
THTS AGRFFMFRT. N0 MOIT I TOK THE "ACCFPT™ OR "AGRFF" RLITTON OR

UG1058_c2_06_061714

Figure 2-6: License Agreement

5. Browse to the location where the Ethernet Controller application will be installed and
click Install (Figure 2-7).

$_ Xilinx - EthernetController Setup: Installation Folder l = ﬁ,l

¥ Setup will install ¥ilinx - EthernetController in the following folder. To install
4 inadifferent folder, dick Browse and select another folder. Click Install to
start the installation.

Destination Folder

: Wilinx \EthernetController Browse...

Space required: 3.0MB
Space available: 31.5GE

Cancel < Back | Install |
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Figure 2-7: Ethernet Controller Installation Location
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6. Click Close after installation is complete (Figure 2-8).

$. Xilinx - EthernetController Setup: Completed l = | |" Eal ‘]

¥ Completed

< ENNNRNEEENENNEEEEENENNEEEEEREEEN

Show details

=

UG1058_c2_08_061714

Figure 2-8: Installation Complete

TIP: To uninstall the Ethernet Controller application after design bring up, open the Control Panel. In
O the Control Panel click All Control Panel Items>Programs and Features and uninstall program
“Xilinx Ethernet Controller - Powered by Xilinx.”

Ready to Bring Up the Design

After all procedures in this chapter are complete, go to Chapter 3, Bringing Up the Design.

10GBASE-KR Ethernet TRD www.Xilinx.com

Send Feedback 16
UG1058 (v2016.2) June 8, 2016 I—\/—l



http://www.xilinx.com
http://www.xilinx.com/about/feedback.html?docType=User_Guides&docId=UG1058&Title=KCU1250%2010GBASE-KR%20Ethernet%20TRD%20User%20Guide&releaseVersion=2016.2&docPage=16

& XILINX

ALL PROGRAMMABLE.

Chapter 3

Implementing and Simulating the Design

<D

This chapter describes how to implement and simulate the 10GBASE-KR TRD.

Implementing the Design

The 10GBASE-KR TRD is implemented using Vivado® Design Suite.

Download the Reference Design Files

See Download Targeted Reference Design Files, page 9 for instructions.

TIP: The Reference Design directory structure is described in Appendix A, Directory Structure.

IMPORTANT: The 10-Gigabit Ethernet MAC IP core (10G MAC) requires a license to build the design.
Obtain the license at the 10 Gigabit Ethernet Media Access Controller (10GEMAC) webpage [Ref 19].
Click Evaluate or Order to access the license.

IMPORTANT: The 10-Gigabit Ethernet PCS/PMA IP core (10GBASE-KR) requires a license to build the
design. Obtain the license at the 10 Gigabit Ethernet PCS/PMA with FEC/Auto-Negotiation
(10GBASE-KR) webpage [Ref 12]. Click Evaluate or Order to access the license.

Generate the Hardware Bitstream

The reference design can be implemented or simulated on a Windows 7 or a Linux
computer. The computer should have Vivado Design Suite 2016.2 installed on it.

1. Launch the Vivado Integrated Design Environment (IDE) and set up the reference design
project.
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« In Windows 7:
Click Start > All Programs > Xilinx Design Tools > Vivado 2016.2 > Vivado 2016.2.
a. In the Tcl console type:

cd <working_dir>/kcul250_1l0gbasekr_trd/hardware/vivado
source scripts/kcul250_10GBASEKR_trd.tcl

e«  On Linux:

a. On a terminal window, change the directory to:
<working_dir>/kcul250_1l0gbasekr_trd/hardware/vivado
b. At the command prompt enter:

vivado -source scripts/kcul250_10GBASEKR_trd.tcl
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The Vivado IDE will display the 10gbasekr_trd project populated with sources
(Figure 3-1).

ﬁ IMPORTANT: When building the design on Windows, if this error occurs: Path Length Exceeds 260
Bytes maximum allowed by Windows, move the kcul250_10gbasekr_trd directory directly under
C:\.

. trd
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Figure 3-1: 10GBASE-KR TRD Design Hierarchy

2. Select the Sources tab.

In the Hierarchy window, two IP Integrator (IPI) block designs are referenced

(Figure 3-2). Block design mac_phy.bd contains the 10-Gigabit Ethernet MAC IP core
(10G MACQ), 10-Gigabit Ethernet PCS/PMA IP core (LOGBASE-KR), the Traffic Generator
and Monitor, and the MicroBlaze™ processor subsystem. Block design
eyescan_sys.bd contains the JTAG to AXI Master IP core, AXI BRAM controller IP core,
DRP to AXI bridge logic, and the MicroBlaze processor subsystem.
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The design top level file kcul1250_10gbasekr_top.v instantiates the block designs
The top level file also instantiates the VIO cores to configure and monitor the
10-Gigabit Ethernet PCS/PMA IP core.
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Figure 3-2: Vivado Project, Sources View

3. In the Flow Navigator, click Generate Bitstream.

4. In the No Implementation Results Available window, click Yes. The bitstream will be
generated and available at:
<working_dir>/kcul250_10gbasekr_trd/hardware/vivado/runs/impl_ru
n/ 10gbasekr_trd.runs/impl_1/kcul250_10gbasekr_top.bit.

O NOTE: /t takes about an hour to build the bitstream.

10GBASE-KR Ethernet TRD www.Xilinx.com Send Feedback 20
UG1058 (v2016.2) June 8, 2016 l—\/—l


http://www.xilinx.com
http://www.xilinx.com/about/feedback.html?docType=User_Guides&docId=UG1058&Title=KCU1250%2010GBASE-KR%20Ethernet%20TRD%20User%20Guide&releaseVersion=2016.2&docPage=20

&

XILINX

ALL PROGRAMMABLE-~

Chapter 3: Implementing and Simulating the D

esign

Generate ELF file for the MicroBlaze Controller in mac_phy.bd

1. To generate the application (ELF file) to run on the MicroBlaze processor, the block
design must be exported and built in the SDK. To launch SDK with the mac_phy block
design exported, in the Tcl console type:

source scripts/launch_sdk_mac_phy.tcl (Figure 3-3).
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Figure 3-3: Export Hardware to the SDK
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2. In the SDK window (Figure 3-4) select File > New > Application Project to build an
application.

Xilinx Tools Window Help

File Edit Source Refactor MNavigate Search Run Project

New Shift+Alt+N | (& Application Project s, glels - 5
Open File... Wl Board Support Package : :
©% Project...
Close Ctri+w = 0% oy E;i ® M.a"' = E|
Close All Shift+Ctrl+W | £4 Source Folder ]| o T e
| \An outline is not available.

[ Folder n_0 Hardware Platform Sp—
|¢ source File

[ Header File

| ¥ File from Template
& Class

[ Other... Ctrl+N
Tap TOr processor mcronraze_sub_system_microblaze_0

£ ; axi_uartlite_0 0x401
EanyEItine Demiers 0 ' eth_axi_stream_gen_mon_0 oxda.

eth_axi_stream_gen_mon_1 Oxda,
mac_phy _ch0 _ten_gig eth_mac_ch0 0x74
mac_phy_chl_ten_gig_eth_mac_chl 0x74

Switch Workspace 4
Restart microblaze_sub_system_mdm_1 0x7e:
microblaze_sub_system_microblaze_0_axi_intc 0x41:
&4 Import... 2_sub_system_microblaze_0_local memory_dlmb_bram_if cntlr oxoo
4 Export... e_sub_system_microblaze_0_local_memory_ilmb_bram_if_cntlr 0x001] |
Properties Alt+Enter \ D]
1 system.hdf [kcul250_10gbasekr top_h... i . 5 N - N
25 L = ] _#Task| @ con EProp| @Ter ~ O [E|SDKlog 1 & —0O
__E;it ¥ | 13:57:07 INFO  : Processing command line opt
[ CuCar (usrauicy — !
P (= Auto Discovered Description Resc
Il )| T Iy

UG1058_c4_06_071514

Figure 3-4: Creating an Application Project in the SDK
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3. In the Application Project window (Figure 3-5) enter the project name as
kcul250_10gbasekr_top and click Next.
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Figure 3-5: Assign Project Name
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4. Select Empty Application and click Finish (Figure 3-6).
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Figure 3-6:
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5. In the project explorer tab (Figure 3-7), right-click kcul1250_10gbasekr_top, select
Import, and under the General tab select File System. Click Next.
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Figure 3-7: Importing File System
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6. Browse to source folder:

Implementing and Simulating the Design

<working_dir>/kcul250_10gbasekr_trd/software/source.

Select the source directory in the left pane and click Finish (Figure 3-8).

The application ELF file will be generated and available at:

<working_dir>/kcul250_10gbasekr_trd/hardware/vivado/runs/
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Debug/kcul250_10gbasekr_top.elf.

| C/C++ - keu1250 10gbasekr_top bsp/system.mss - Xilinx SDK

P 15 kcul250_lOgbasekr_top

P il kcul250_10gbasekr top_bsp

~ (@ kcul250_10gbasekr_top_hw_platform_0
{7 mac_phy_bd.tcl
S system. hdf

o -8 @& - g
| | &
i B\ BE|¥ <"

File Edit Source Refactor MNavigate Search Run Project Xilinx Tools Window Help

File system

Import resources from the local file system.

= [FeE

i ’E‘ 5= ou % @ma =0
lj.l | [] An outline is not available.

From directory: kcul250_10gbasekr_trd/software/source | - ] I Browse... ]

[1 (= source

[ [& CommandDesc.h
1 T Iscript.ld

[ [¢ platform_config.h
[ [ platform.c

[ [ platform.h

O B README.txt

[ [g regaccess.c

[H!ter}ypes‘.‘l [ Select All ] [ Deselect All ]

Into folder: Ikcu1250_10gbasekr_top

] I Browse...

=)

Options
[] Overwrite existing resources without warning

[ Create top-level folder

44 Target Connections 5 £ =

Advanced >>

-4 Local [default]
P (= Auto Discovered

| o* % kcul1250_l0gbasekr_top

ja

i

BE-O

pcessing command line opt

@ <sack | I

Cancel J 0}

Figure 3-8:

10GBASE-KR Ethernet TRD
UG1058 (v2016.2) June 8, 2016

www.Xilinx.com

UG1058_c4_10_092414

Importing Software/Source Directory

l Send Feedback l 26


http://www.xilinx.com
http://www.xilinx.com/about/feedback.html?docType=User_Guides&docId=UG1058&Title=KCU1250%2010GBASE-KR%20Ethernet%20TRD%20User%20Guide&releaseVersion=2016.2&docPage=26

8 XI LINX Chapter 3: Implementing and Simulating the Design

ALL PROGRAMMABLE-~

Generate ELF file for the MicroBlaze Controller in
eyescan_sys.bd

1. To generate the application (ELF file) to run on the MicroBlaze processor, the design
must be exported and built in the SDK. To launch SDK with eyescan_sys block design
exported, type:

source scripts/launch_sdk_eyescan.tcl

in the Tcl console (Figure 3-9).
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5% Open Block Design %_ﬁfy&scan,sys,\ — eyEsCan_sys (eyescan_sys.bo) (1) O:
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> @% Open Harchware Manager E # Taunch_sdk -workspace runs/inpl_run/l0gbasekr_trd. sdk/nac_phy -hwspec runs/impl_run/l0ghasekr_trd. sdk/mac_phy/koul250_10ghasekr_top. hdf
* INFO: [Wivado 12-393] Launching SDK. ..
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1 m I []
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= Tel Console | © Messages [ log 2 Reports 3 Design Runs

Interface Connection: pcie_drp_1_1
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Figure 3-9: Launch the SDK
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Chapter 3:

Implementing and Simulating the Design

In the SDK window (Figure 3-10) select File > New > Application Project to build an

1.hdf - Xilinx

'Ele | Edit Source Refactor MNavigate Search Project Xilinx Tools Bun Window Help
| New Shift+Alt+N » & Application Project w @ 4 -
Open File... 4 SPM Project
m Board Support Package :} ﬁ
Close Ctrl+w =4 Project = g mox » = =
Close All Shift+Ctriew | S _ (= i !
[1/|/An outline is not
A% Source Folder atform_0 Har(— | oo
[ Folder
[¢] source File
|5 Header File
[ File from Template
Class
4 4
% Other... Ctrl+N
- - —pro— blaze_0
Convert Line Delimiters To b axi_bram_ctrl_0 0xc2000000 0xc2001E£E B
drp_bridge_0 0xc0000000 0xcO000EEE
drp_bridge_1 0xc0001000 OxcO001Eff
Switch Workspace » 1b_bram_if_cntlr_0 0x00000000 0x00003££E
Restart b_bram_if_cntlr_0 0x00000000 0x00003£££f
£23 Import present in the design
e Export ctrl_0 axi_bram_ctrl ||
el A hrnn bl mammn e L=
Properties Alt+Enter | [v]
1 system.hdf [kcul250_10gbasekr_eyesc...]
T Bc Ep @7 = B [E|sDKLog & BE = O
Exit =
= ~ | 10:56:38 INFO  : Processing commanc
b = Auto Discovered 0 items 10:56:41 INFO : Launching XSDB set
Description
a | ) U L)
UG1058_c4_229_092414
Figure 3-10: Building an Application Project in the SDK
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2. In the Application Project window (Figure 3-11) enter the project name as
kcul250_10gbasekr_eyescan and click Next.

10GBASE-KR Ethernet TRD
UG1058 (v2016.2) June 8, 2016

Application Project

Create a managed make application project.

Project name: |kcul250_10gbasekr _eyescan|

[] Use default location

Target Hardware

Hardware Platform: | kcul250 10ghasekr eyescan_hw platform 0

2] vew]

Processor: [ mb_ps_microblaze_0

|

Target Software

www.Xilinx.com

Language: OC O C++
05 Platform: standalone 3]
Board Support Package: O Create New |kcul250 10gbasekr eyescan_bsp |
@ [ Next = l [ B'ms;h i [ Cancel ]
UG1058_c4_239_092414
Figure 3-11: Assigning a Project Name In the SDK
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Chapter 3:

3. Select Empty Application and click Finish (Figure 3-12).

Templates

Create one of the available templates to generate a fully-functioning

application project.

Available Templates:

Peripheral Tests
Memory Tests

IwIP Echo Server
Dhrystone

SREC Bootloader

Zyng FSBL

RSA Authentication App
Empty Application

Zyng DRAM tests
Xilkernel POSIX Threads Demo
Hello World

A blank C project.

e |

Cancel

10GBASE-KR Ethernet TRD
UG1058 (v2016.2) June 8, 2016

Figure 3-12:
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4. In the project explorer tab (Figure 3-13), right-click kcu1250_10gbasekr_eyescan,
select Import, and under the General tab select File System. Click Next.

s0K

C/C++ - keu1250_10gbasekr_eyescan_bsp/system.mss - Xilinx SDK
File Edit Source Refactor MNavigate Search Project Xilinx Tools Run Window Help

il B4 b @& - = =
A +

Select [— |
1 - — N\

P t Expl 2 BEE ¥ 2 . . P B8
B Project Explarer | =2 5 Import resources from the local file system into an existing project. | gl I

b -5 kcul250_l0gbasekr_eyescan
P (i kcul250_10gbasekr_eyescan_bsp
= (@ kcul250_l10gbasekr_eyescan_hw_platfiorm_0

eyescan_sys_bd.tcl o
Gey i - [= General —

& Archive File

Select an import source:

|4z system. hdf

& Existing Projects into Workspace
[, File System
£, Preferences

P &= C/C++

b & Install

I (= Remote Systems

P = Run/Debug

b = Team

E1N

(R Il D)

i | | N | | —_—
44 Target Connections 2 &£ = 5 @ ." Next > I | | [ cancel =
4 Local [default] T0:56.36 INFO . Processing commanc

P = Auto Discovered 0 items 10:56:41 INFO : Launching XSDB ser

Description

T i T || G [

=5 kcul250_10gbasekr_eyescan

UG1058_c4_259_092414

Figure 3-13: Importing File System
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5. Browse to source_eyescan folder:
<working_dir>/kcul250_10gbasekr_trd/software/source_eyescan
Select the source_eyescan directory in the left pane and click Finish (Figure 3-14).
The application ELF file will be generated and available at:

<working_dir>/kcul250_10gbasekr_trd/hardware/vivado/runs/
impl_run/l1l0gbasekr_trd.sdk/eyescan/kcul250_10gbasekr_eyescan
/Debug/kcul250_10gbasekr_eyescan.elf

"l C/C++ - keu1250_10gbasekr_eyescan_bsp/system.mss - Xilinx SDK
File Edit Source Refactor Navigate Search Project Xilinx Tools Run Window Help

wij B-% - b e
o File system A F++ 7
[ Project Explorer 2 | = % | ¥ ¥ | Import resources from the local file system. 7 i =
b £ kcul250_l0gbasekr_eyescan r
P {H kcul250_10gbasekr eyescan bsp From directory: [jkculzso_mgbasekr_trd,fsaftwarejscurce_eyescan | - l [ Browse... ]
< (@ kcul250_10gbasekr_eyescan_hw_plati
[ = source_eyescan O [g drp.c 2

[J eyescan_sys_bd.tcl
|43 system. hdf O [¢ drp.h
[ [¢ es_controller.h

[ [¢ es_simple_eye_acq.c
[l [g es_simple_eye_acq.h
[ [§ eyescan_main.c

[ T Iscript.Id

interIYpesmH Select All H Deselect All ]

Into folder: |kcu1250710gha5ekrﬁeyescan I [ Browse...

Options
[] Overwrite existing resources without warning

[] Create top-level folder

43 Target Connections 2 -
4 Local [default] anc
I» (= Auto Discovered pal

@ < Back |_ | [I_ Finish ” Cancel ]

=

#

)

=% kcul250_10gbasekr_eyescan

UG1058_c4_269_092414

Figure 3-14: Selecting the software/source Directory
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Generate Bitstream For Download

1. Create a bitstream for download. In the Vivado Tcl Console (Figure 3-15) run the
command:

source scripts/create_download_bit.tcl

Flle Edit Flow Tools Wincow Lawout ¥iew Help Q Search commands

dAdrEwoRBX 39PN SXK I L:’H e |©@ write_bitstream Complete

Flow Navigatar < | Block Design - eyesran_sys x|

Qs Ay mac_phy % 5 eyescan_sys X 1
Sources -0 x I=Diagram x [ Address Editar X o x

4 Project Manager =
o =
45 Project Settings Ot R

o Design Sources (1) (]

3 & evescan_sys b

.. s | g (2]

@ Adet sources bl keu1250_10gbasekr_top (keul250_100basekr_top ) (10) -
' Language Templates @ debounce_reset_chd - debouncer (debouncers H—H
£F Ip Catalng # debounce_reset_chl - debouncer (debouncers) D%D
9—48 mac_phy_wrapper_i - mac_phy_wrapper (mar_phy_wrapper ) (1]
|‘ IP Integrator §k}hmac_phv_i - mac_phy (mac_phy b (1) [} [
Y / &—@ mac_phy (mac_phy.v) (14)
4% Create Elock Design 98 BYRSCAN_SyS_Wrapper_i - BYRSCAN_SYS_WrapDer (Byescan_sys_ wrapper ) (1)
% Open Block Design G- eyescan_sys | - eyescan_sys (evescan_sys bl (1)

é—-@ BYRSCAN_SYE (eyescan_syeod (11)
oLk vio_training_drp_ch0 - wvio_training_drp (wio_training_drp xci)
o= {Frvin_training_drp_chl - wio_training_crp (do_training_crp.xcl

&3 Generate Block Desian

RS LA EEL R

9 SmvETD o~-LFrIvio_stat_chQ - vio_stat (vio_stat k)
ﬁ Simulation Settings o= Fr]vio_cfg_chO - wio_cfg (vio_cfg xcl) .I.....,.‘m..., =
(@) Run simulation o~ {FC1vio_stat_chl - vio_stat (vio_stat el |D
o~LFrvio_cfo_chl - wio_cfg (vio_cfg xci) = appgan
4 RTL Analysis Hierarchy |F Sources Libraries Compile Order :D
> &% Open Elaborated Design £ Sources  Fl Design @ Signals I_—_l
4 Synthesis Propertias —oex @_
Q} Synthesis Settings - k
e
P Run synthesis L
J.
> [@* Open Synthesized Design
4 | L

Implementation

ﬁ Implementation Settings « (D3
> Run Implementation

= Tl Consale —Ouv X
> @ Open Implemented Design g source scripts/launch_sdk_mac_phy.tcl &
o # Taunch_sdk -workspace runs/impl_run/10ghasekr_trd.sdk/mac_phy —hwspec runs/impl_run/l0ghasekr_trd. sdk/mac_phy,/koul250_10ghasekr_top. hdf
4 Program and Debug = INFO: [vivado 12-393] Launching SDK...
Q} Bitstrearn Settings (il1} INFO: [Wivado 12-417] Running xsdk -workspace runs/impl_run/lOghasekr_trd.sdk/mac_phy -hwspec runs/impl_run/10gbasekr_trd. sdk/mac_phy/kcul250_10gbasekr_1
¥ ) 5l INFO: [Divado 12-3157] SOK Taunch initiated. Please check console for any further messages.
¥ Generate Bitstream Ea source scripts/launch_sdk_eyescan.Tel
> i@ Open Harcware Manager R # Taunch_sdk -workspace runs/impl_run/10gbasekr_trd. sdk/evescan —hmspec runs/Ampl_run/l0ghasekr_trd. sdk/eyescan/koul250_10gbasekr_eyescan., hdf
>< INFO: [Wivado 12-393] Launching SDK. ..
INFO: [Wivado 12-417] Running xsdk -workspace runs/impl_run/10ghasekr_trd.sdk/eyescan -hwspec runs/inpl_run/10ghasekr_trd.sdk/eyescan/koul2S0_10ghasekr_g
INFO: [Wivado 12-3157] 50K Taunch initiated. Please check console for any further messages. E
[«] 1l ] [r]

source scripts/oreate_download_bit.tcl I

S Td Console [ © messages [Log | 5 Reports | 3 Design Runs

UG1058_c4_11_092414
Figure 3-15: Run Script to Create download.bit
The create_download_bit.tcl script runs the update_mem command and combines

kcul250_10gbasekr_top.bit, kcul250_10gbasekr_top.elf and
kcul250_10gbasekr_eyescan.elf into single BIT file available at:

<working_dir>/kcul250_10gbasekr_trd/hardware/vivado/runs/impl_run/
10gbasekr_trd.runs/impl_1/kcul250_10gbasekr_download.bit
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Simulating the Design

The 10GBASE-KR TRD can be simulated using the Vivado Design Suite simulator. The TRD
can also be simulated using Modelsim/Questa. Refer to Vivado Design Suite User Guide
Logic Simulation (UG900) [Ref 14], for information describing how to run simulations with
different simulators.

The simulation environment sets up the Traffic Generator and Monitor blocks of the TRD.
The Traffic Generator for channel 0 generates 10 packets which are transmitted to the
10-Gigabit Ethernet MAC IP core. The packets are looped back on the PHY and become
receive packets on channel 1. Similarly, the Traffic Generator for channel 1 generates 10
packets which are transmitted to the 10-Gigabit Ethernet MAC IP core. The packets are
looped back on the PHY and become receive packets on Channel 0. The testbench waits to
receive the 10 packets on each channel without errors and then ends the simulation with a
Simulation Passed message. Simulating the AXI UART Lite IP and MicroBlaze processor
subsystem takes a lot of time. In order to speed up simulation the Traffic Generator and
Monitor block is not configured using its AXI Lite interface connected to the MicroBlaze
processor subsystem. The Traffic Generator and Monitor block provides a port tg_config to
configure the block. This port is used only for simulation. Table 3-1 shows the bitmap for
this port.

Table 3-1: Traffic Generator Configuration Port

Bit Position Description
0 Enable loopback for external generator mode.
1 Enable generator for internal generator mode.
31:16 Ethernet frame data payload size.
Allowed values (46 bytes to 1,500 Bytes).

The testbench for the 10GBASE-KR TRD is available at:

<working_dir>/kcul250_10gbasekr_trd/hardware/sources/testbench/tb.v.

f IMPORTANT: Before running a simulation the kcul250_10gbasekr_ref design project must be open and
step 1 under Generate the Hardware Bitstream has been executed.
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To run a simulation in Modelsim/Questa:

1. In the Flow Navigator, under Simulation, click Run Simulation > Run Behavioral
Simulation (Figure 3-16).

File Edit Flow Tools Window Layout  Yiew Help Q. Search commands |

g8 m R B X e - 3 #1 @5 9 | 20 3 |23 Deraun Layout M & Y write_bitstream Complete
Flow Navigator «| | Block Design - mac_phy x|
Z % sources _Ow x %= Diagram X 8 Address Editor X [ R E s
) a=z=ma" R 2l A& mac_phy »
4 Project Manager 3 e
) . - Design Sources i) = <% = ] E|
@ Praject Senings @2 keul250_10gbaseke_top (kcul1250 10gbasekr top.) (9) o |
gﬁ Acdd Sources ¥ debounce_reset_ch0 - debouncer (debouncer v N —l
g: P Catalog ¥ debounce_reset_chl - debouncer (dehouncer v “\% *
¥ mac_phy_wirapper_i - mac_phy_wrapper (mac_phy wrapp %
Cvio_training_drp_chQ - vio_training_drg (vo_training_dro £ |
a —=
| iz In-leqramr | win_training_drp_chl - wio_training_drg (vio_training_dro | = »i»« #
% Create Block Design vio_stat_ch0 - vio_stat (vio_stat xci) g i
5* open Block Design LFvio_cfg_chO - wio_cfg (vo_cfg.xci) =i
‘%} c Block Des| wio_stat_chl - wio_stat {vio_statxci) Q
S e es o Cwin_cfg_chl - wio_cfg (wio_cfg.xci) Py =
) ) = 1P Update Log (2} i i
4 Simulation & Data Files (1) o
ﬁ Simulation Settings >~ Constraints (2) =1 &%
f; 4] LI ] vOf | =
Run Simulation =
@ Run Behavioral Simulation pile Order & !E 5%‘;
4 RETL Analysis Run Post-Synthesis Functional Simulation @@ Signals ﬁ al = =
E'& Open Elaboratd Run Post-Synthesis Timing Simulation @ — e —
= EE 2c
Run Post-Implementation Functional Simulation @r = |
4 Synthesis Run Post-Implementation Timing Simulation
ﬁ synthesis Settings |
=
b Run Synthesis
2 Ig]a’ Qpen Synthesized Design
4 Implemertation [~]
&5 Implernentation Senings LI — ] = |
[» Run Implementation Tcl Console e 0 S
© ¥ Open Implemented Design | | % | | Loading data files... =
e : Updating memory content...
= ! (Creating hitstream...
4 Program and Debu i
- i 4 i1} P INFO: [Bitstream 40-174] Creating early silicon bitstream.
@ Bitstream Settings (Writing bitstream runs/impl_run/10gbasekr_trd. runs/impl_1/kcul250_10gbasekr_download.bit...
?jcenera[e Bitstream Supdate_mem: Time (5): cpu = 00:00:28 ; elapsed = 00:00:28 . Memory (MB): peak = 5585.500 ; pain = 22.625
ﬁ“ Qpen Hardware Manager :
L
2 Td Console O Messages [ Log 2 Reponts 3> Design Runs
Launches Questasim/Modelsim for behavioral simulation
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Figure 3-16: Run ModelSim Simulation
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To run a simulation using the Vivado Design Suite Simulator:

1. In the Flow Navigator, under Simulation, click Simulation Settings.

2. In the Project Settings window (Figure 3-17), select Vivado Simulator in the Target
simulator field and click Yes when asked if it is OK to change your target simulator to
Vivado Simulator. click OK in the Project Settings window.

“ Pproject Settings

m) | Simulation |

General Target sitnulator: |V|vad0 sirmulator - |
@ Sirulator language: |Mixed - |
aimulation Sirnulation set |'@' sim_1 = |
& Simulation top module name |tb | D
Synthesis
|] [¥ Clean up simulation files

[] Cenerate scripts only

o0t
Bitstrearn D
= | sm 1y (-]
P = = — 1
YHDL Syntax 52 =
Explicit Declarations ¥
Enahble fast simulation models O
More ¥LOGC Options
More ¥ COM Optiohs
Select an option above to see a description of it
I OF ] I Cancel ] | Apply

UG1058_c4_13_062314

Figure 3-17: Set Simulator to Vivado Simulator

3. In the Flow Navigator, under Simulation, click Simulation > Run Behavioral
Simulation.
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Chapter 4

Reference Design Details

This chapter describes the hardware design and software components.

Hardware

Figure 4-1 shows a block-level overview of the 10GBASE-KR TRD.

KCU1250 Board
Java GUI/Driver XCKU040-2FFGA1156C FPGA
and Vivado
Design Suite e | P
othe | ¢ &
Control UARTY S & m
Computer 1 - : AXI LITE
B /‘ g 8 3 Traffic 64 bits at 156,256MHz o
53 g Generator X -
@ g and 10G w . .| smA [#1
o £ 2 Monitor MAC ‘Q . J Line [*10
] = an) CARD
D2 = 9]
- =
23 Traffic -+ 2
Generator s
and CHANNEL 0 8
Monitor AXI LITE
&9 o 64 bits at|156. 5 A =__
'; O X LIIJ ’ \ N Li =:
& = 2 AXIDRP | _ 10G T N v CAT:D
8 = S Bridge | MAC s
= [0}
5 S
g AXI DRP D‘_R
ﬁ £ E Bridge <—|
o2 %
< AXI BRAM
%—’ a Controller
BRAM
Eyescan System
Integrated Blocks in FPGA Custom Logic AXI-Lite (Master to Slave)
B Xilinx IP On Board —— AXI-Stream UG1058_c1.01.091714

Figure 4-1: 10GBASE-KR TRD Block Diagram
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The details of the hardware architecture are provided in three sections:

« Data Plane Components: Describes the 10-Gigabit Ethernet PCS/PMA IP core
(LOGBASE-KR), 10-Gigabit Ethernet MAC IP core (10G MAC) and the Traffic Generator
and Monitor.

« Control Plane Components: Describes the MicroBlaze™ processor subsystem and the
peripherals connected to it.

» Eyescan System Components Describes the MicroBlaze processor subsystem and JTAG
to AXI Master IP core that communicate with the DRP port of the transceivers to collect
data samples and create an eye diagram.

+ Clocking and Reset: Describes how clocks and resets are distributed to the different
components in the 10GBASE-KR TRD.

Data Plane Components

The 10-Gigabit Ethernet PCS/PMA IP (10GBASE-KR) and 10-Gigabit Ethernet MAC IP (10G
MAC) cores constitute a 10 Gb/s Ethernet channel. There are two channels in the
10GBASE-KR TRD; channel 0 and channel 1. The data source for each channel is a Traffic
Generator implemented in the FPGA that drives the 10G Ethernet MAC.

10-Gigabit Ethernet PCS/PMA IP Core

The 10-Gigabit Ethernet PCS/PMA (10GBASE-KR) IP core provides an XGMII interface to
connect to a 10-Gigabit Ethernet MAC IP core and implements a 10.3125 Gb/s serial
single-channel PHY (GTH transceiver) brought out to TXN/TXP and RXN/RXP I/O pins that
are connected to differential SMA connector pairs on the board. SMA cables connect these
signals to the backplane.

The 10GBASE-KR IP core is configured to support auto negotiation (AN) and forward error
correction (FEC). The MDIO interface is disabled and configuration and status vectors are
used to manage the core.

A license can be obtained at the 10 Gigabit Ethernet PCS/PMA with FEC/Auto-Negotiation
(10GBASE-KR) webpage [Ref 12]. More information is available in the LogiCORE IP
10-Gigabit Ethernet PCS/PMA Product Guide (PG068) [Ref 13].

Relevant bits of the configuration and status vectors are brought out to Virtual
Input/Output (VIO) IP cores to configure and monitor the IP. The training port of the
10-Gigabit Ethernet PCS/PMA is also connected to a VIO IP core to access the transceiver's
DRP address map.

More VIO IP core information is available at the Virtual Input/Output (VIO) webpage [Ref 15]
and in the LogiCORE IP Virtual Input/Output Product Guide for Vivado Design Suite (PG159)
[Ref 16]. Details about the DRP address map is available in UltraScale Architecture GTH
Transceivers User Guide (UG576) [Ref 11].
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10-Gigabit Ethernet MAC IP Core

The 10-Gigabit Ethernet MAC (10G MAC) IP core is a single-speed, full-duplex, 10-Gb/s
Ethernet Media Access Controller. This 10G MAC connects to the PHY layer through the
XGMII interface. The internal Traffic Generator drives data on the AXI4-Stream ports of this
IP.

A license can be obtained at the 10 Gigabit Ethernet Media Access Controller (10GEMAC)
webpage [Ref 19]. More information is available the LogiCORE IP 10-Gigabit Ethernet MAC
Product Guide (PG072) [Ref 17].

Traffic Generator and Monitor

Figure 4-2 shows the Traffic Generator and Monitor. The traffic generator block generates
Ethernet Traffic. The performance monitor block monitors the AXI4-Stream ports of the
10-Gigabit Ethernet MAC IP core and reports throughput.

The User Control and Status Register block passes information to and from the Ethernet
Controller application using the MicroBlaze processor subsystem.

Traffic Generator
PHY status »| User Control and Status AXI-Lite transactions to
> . and from the MicroBlaze
. Registers
Processor Subsystem
. AXIl4-Stream TX traffic to
Generator (Internal) > e MAC
AXl4-Stream RX traffic Performance Monitor
from the MAC

UG1058_c5_02_070814

Figure 4-2: Traffic Generator and Monitor

Internal Traffic Generator, Generator Module

The internal Traffic Generator module generates Ethernet packets based on user inputs
provided from the Ethernet Controller application running on the control computer. Data
payload size can be from 46 bytes to 1,500 bytes. Table 4-1 shows the packet format
generated by the internal Traffic Generator module.
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Table 4-1:  Packet Format of Generated Packets
Byte 7 Byte 6 Byte 5 Byte 4 Byte 3 Byte 2 Byte 1 Byte 0
Source Address Destination Address
Sequence Number Length Source Address
.................................... Sequence Number Sequence Number

Sequence Number

The source and destination MAC addresses are parameters into this block. The length field
is the data payload value. The actual length of a packet generated by this block is:

« 14 bytes of header (Destination Address + Source Address + Length/Type Field) +

Data paylo

ad

The sequence number field indicates packet count and increments by one every packet.

The generated packets are transmitted on AXI4-Stream interface to the 10-Gigabit Ethernet
MAC IP core. Table 4-2 shows the parameters and ports on the generator module.

Table 4-2: Generator Module Parameters and Ports

Port/Parameter Name Type Description
Source MAC Address

XIL_MAC_ID_THIS Parameter | For channel 0 = 48'h111100000000
For channel 1 = 48'h222200000000
Destination MAC Address

XIL_MAC_ID_OTHER Parameter | For channel 0 = 48'h222200000000
For channel 1 = 48'h111100000000

Clock and reset ports

reset Input Synchronous reset.

tx_axis_clk Input 156.25 MHz clock transmit ports on the AXI4-Stream interface.

Transmit Ports on the AXI4-Stream

Interface

tx_axis_tdata[63:0] Output Data to be transmitted to the 10-Gigabit Ethernet MAC IP core.
The transmit keep signal is used to determine which data bytes are valid
on tx_axis_tdata during a given beat (this signal is valid only if
tx_axis_tvalid and tx_axis_tready are both asserted).

tx_axis_tkeep[7:0] Bit O corresponds to the Ie.ast. s.|gn|f|cant byte on tx_axis_tdata and bit 7
corresponds to the most significant byte.
When tx_axis_tlast is not asserted, the only valid value is 0xFF. When
tx_axis_tlast is asserted, valid values are 0x1, 0x3, 0x7, 0xf, O0x1f, Ox3f,
0x7f and Oxff.

tx_axis_tlast Output End offramelpdlcator on transmit packets. Valid only along with assertion
of tx_axis_tvalid.

tx_axis_tvalid Output Source ready t.o provide transmlt data. Indicates that the generator is
presenting valid data on tx_axis_tdata.

tx_axis_tuser Output | If asserted indicates an underrun frame. This is tied to 1 'b0.
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Table 4-2: Generator Module Parameters and Ports (Cont’d)

Port/Parameter Name Type Description

Destination ready for transmit. Indicates that the 10-Gigabit Ethernet
. MAC IP core is ready to accept data on tx_axis_tdata.

tx_axis_tready Input . . . . .
The simultaneous assertion of tx_axis_tvalid and tx_axis_tready marks the
successful transfer of one data beat on tx_axis_tdata.

Control Ports

enable_gen Input Enable internal generator.

data_payload Input Size of the payload (46 bytes to 1,500 Bytes).

The data flow with internal generator mode enabled on the Traffic Generator for channel 0
is:

Generator module CHO — CHO TX AXI4-Stream interface of the 10-Gigabit Ethernet MAC

IP —» CHO TX XGMII interface of the 10-Gigabit Ethernet PCS/PMA IP — CHO TXN/TXP serial
lines — loopback to CH1 RXN/RXP serial lines - CH1 RX XGMII interface of the 10-Gigabit
Ethernet PCS/PMA — CH1 RX AXI4-Stream interface of the 10-Gigabit Ethernet MAC IP core

The data flow with internal generator mode enabled on Traffic Generator for channel 1 is:

Generator module CH1 — CH1 TX AXI4-Stream interface of the 10-Gigabit Ethernet MAC
IP - CH1 TX XGMII interface of the 10-Gigabit Ethernet PCS/PMAIP — CH1 TXN/TXP serial
lines — loopback to CHO RXN/RXP serial lines — CHO RX XGMII interface of the 10-Gigabit
Ethernet PCS/PMA IP — CHO RX AXI4-Stream interface of the 10-Gigabit Ethernet MAC IP
core

Ethernet Performance Monitor

The Ethernet performance monitor block snoops for valid transactions on the AXI4-Stream
interface ports of the 10-Gigabit Ethernet MAC IP core and keeps track of bandwidth
utilization. A timer within this block counts the clocks until one second has elapsed, during
which time counters have collected data about link performance.

Four counters collect information on the transactions on the AXI4-Stream interface:

« TX Payload Byte Count. This counter counts bytes transferred when tx_tvalid and
tx_tready signals are asserted between the Traffic Generator block and the 10G MAC. At
the end of the packet (tx_tlast) 14 bytes of header are subtracted from the count to get
payload count.

« TX Packet Count. This counter counts the number of transmitted packets. The counter
increments when tx_tvalid and tx_tready and tx_tlast signal are asserted.

« RX Payload Byte Count. This counter counts bytes transferred when rx_tvalid and
rx_tready signals are asserted between the Traffic Generator block and the 10G MAC. At
the end of the packet (rx_tlast) 14 bytes of header are subtracted from the count to get
payload count.
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« RX Packet Count. This counter counts the number of received packets. The counter
increments when rx_tvalid and rx_tready and rx_tlast signal are asserted.

The counts are truncated to a four-byte resolution, and the last two bits of the register
indicate the sampling period. The last two bits transition every second from 00 to 01 to 10
to 11. The software polls the performance registers every second. If the sampling bits are
the same as the previous read, then the software needs to discard the second read and try
again. When the one-second timer expires, the new byte counts are loaded into the
registers, overwriting the previous values. Table 4-3 shows the parameters and ports on this

module.

Table 4-3: Ethernet Performance Monitor Parameters and Ports

Port/Parameter Name Type Description

Defines the number of 156.25 MHz clock cycles equivalent to 1 sec.

ONE_SEC_CLOCK_COUNT | Parameter Default value is 32 'h9502F90.

Clock and Reset Ports

reset Input Synchronous reset.

clk Input 156.25 MHz clock.

Transmit Ports on the AXI4-Stream I

nterface

tx_axis_tdata[63:0] Input Data to be transmitted to the 10-Gigabit Ethernet MAC IP core.
The transmit keep signal is used to determine which data bytes are valid
on tx_axis_tdata during a given beat (this signal is valid only if
tx_axis_tvalid and tx_axis_tready are both asserted).
tx_axis_ tkeep(7:0] Bit O corresponds to the least significant byte on tx_axis_tdata and bit 7
- - pL/: corresponds to the most significant byte. When tx_axis_tlast is not
asserted, the only valid value is 0xFF.
When tx_axis_tlast is asserted, valid values are 0x01, 0x03, 0x07, 0xOF,
0x1F, 0x3F,0x7F, and OxFF.
. End of frame indicator on transmit packets. Valid only along with
tx_axis_tlast Input . . .
assertion of tx_axis_tvalid.
. . Source ready to provide transmit data. Indicates that the generator is
tx_axis_tvalid Input . . .
presenting valid data on tx_axis_tdata.
tx_axis_tuser Input If asserted indicates an underrun frame. This is tied to 1'bO0.
Destination ready for transmit. Indicates that the 10-Gigabit Ethernet
. MAC IP core is ready to accept data on tx_axis_tdata.
tx_axis_tready Input

The simultaneous assertion of tx_axis_tvalid and tx_axis_tready marks the
successful transfer of one data beat on tx_axis_tdata.

Receive Ports on the AXI4-Stream In

terface

rx_axis_tdata[63:0] Input Data received by the 10-Gigabit Ethernet MAC IP core.
The receive keep signal is used to determine which data bytes are valid
rx_axis_tkeep([7:0] on rx_axis_tdata during a given beat (this signal is valid only if
tx_axis_tvalid and tx_axis_tready are both asserted).
rx_axis_tlast Input End of frame indicator on received packets. Valid only along with

asser-tion of rx_axis_tvalid.
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Table 4-3: Ethernet Performance Monitor Parameters and Ports (Cont’d)

Port/Parameter Name Type Description
. . Source ready to provide data. Indicates that the MAC is presenting valid
rx_axis_tvalid Input .
data on rx_axis_tdata.
rx_axis_tuser Input If asserted indicates a good packet is received.
Destination ready for receive. Indicates that the loopback is ready to
accept data on rx_axis_tdata.
. The simultaneous assertion of rx_axis_tvalid and rx_axis_tready marks
rx_axis_tready Output

the successful transfer of one data beat on rx_axis_tdata.

The 10-Gigabit Ethernet MAC IP core doesn't look at this signal and
sends received data whenever available.

Performance Statistics Ports

tx_byte_count Output | Number of bytes transmitted in one second.
tx_pkt_count Output | Number of packets transmitted in one second.
rx_byte_count Output Number of bytes received in one second.
rx_pkt_count Output | Number of packets received in one second.

User Control and Status Registers

The user selections made in the Ethernet controller application are passed to the Traffic
Generator and Monitor using this block. An AXI4-Lite interface is required for the
MicroBlaze processor subsystem to execute reads (status) and writes (control) to this block.
The AXI4-Lite to the AXI4-Lite IP Interface IP core (PG142) [Ref 18] is instantiated in the
design to read and write to a register map file.

Providing an AXI4-Lite slave interface provides the flexibility of using this module in other
designs. To reuse this block, the control and status signals into the register map must be
changed. Appendix C, User-Space Registers describes the registers implemented in the
Traffic Generator and Monitor block. Figure 4-3 shows the user register interface.

AXI-4 Lite transactions
to and from the
MicroBlaze Processor

AXI4-Lite to IPIF

__ Control: Internal traffic generator
selection, payload size, etc.

Status and Control

Register Map
Status: Performance, PHY

status, etc.

A

UG1058_c5_03 061814

Figure 4-3: User Register Interface

Control Plane Components

The Ethernet Controller application running on the control computer sends control
information and receives status to and from different components of the 10GBASE-KR TRD
using the MicroBlaze processor subsystem.

10GBASE-KR Ethernet TRD
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MicroBlaze Processor Subsystem and AXI Interconnect

The IP cores required to support the MicroBlaze processor and create a subsystem are:

« MicroBlaze local memory
« Processor system reset
« MicroBlaze debug module

« AXIInterrupt controller

In Vivado IP], adding the MicroBlaze IP core and running the connection automation creates
the MicroBlaze processor system shown in Figure 4-4.

microblaze_0_axi_intc

e axi
microblaze_0_xlconcat s_axi_aclk

axi_aresetn
L R—— s inteTupi e || f—
In1[0:0]

processor_clk

Concat
AXIlInterrupt Controller (Pre-Production)
Clk [T
microblaze 0 microblaze_0_lecal_memory
mdm_1 [ 4=mreRRUPT nl J?N ME
MEDEBUC. A 1 — q . Dumed:|T Ml me
il Hf=r M 3’ ILME= [} I Hl{=F
Dehug_S\’S_RstJ— Ll 'cm am M_AX DP;} A LME_Clk
rst_Clk_100M Reset 7 ' ME_Rst
i Blazd Debug Modu le (MDM] (Pre-Proffuction)
lowest_sync_clk mb_reset MicroBlaze (Pre-Production)
xt_reset_in bus_struct_reset][0:0] g
Lx_reset_in peripheral_reset[0:0] m
mb_debug_sys_rst  imerconnect_aresetn [0:0] me—
m_locked peripherl_areset n[0:0]]
Processor System Reset (Pre-Production) |
S00_ACLK. MOO_ XI5 1
_ARESETN
moo_aclk | -alfb

MOO_ARESETH

Axl Interconnect (Pre-Production

UG1058_c5_04_062314

Figure 4-4: IPI-Generated MicroBlaze Processor System

The AXI interconnect IP allows the MicroBlaze processor subsystem to communicate with
the AXI Interrupt controller IP using the AXI4 memory mapped interface.

The 10GBASE-KR TRD AXI interconnect IP is reconfigured to have six master ports instead
of one. The six master ports connect to six AXI slaves:

« AXlinterrupt controller

« AXI UART Lite which communicates with the Ethernet Controller application running on
the control computer

« Channel 0 - 10-Gigabit Ethernet MAC IP core
« The Traffic Generator and Monitor connected to channel 0

+ Channel 1 - 10-Gigabit Ethernet MAC IP core
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+ The Traffic Generator and Monitor connected to channel 1

The AXI interconnect enables communication between the MicroBlaze processor subsystem
(Master) and six peripherals (Slaves).

The address range assigned to each peripheral is shown in Figure 4-5. The application
driver running on the MicroBlaze processor subsystem will use these addresses to map
read/write transactions from the Ethernet Controller application to the AXI UART Lite to the
MicroBlaze processor subsystem to other peripherals and back.

B Address Editor > E= Diagram

Q, Cell [ Interface Pin | Base Mame | Offset Address | Range | High Address

= @-{F microblaze_sub_system/microblaze_0

g >-H Data (32 address hits @ 4G)

I@ﬂ = ayi_uartlite_0 5] Reg Oxd0Ea0000 718 - QxdOB0FFFF
= microblaze_sub_systemfmicroblaze_0_local_memoaoryfdimb _bram_if_cntlr SLMBE Mem OOO0Q0000 128K = QOxOOO1FFFF
== gth_axi_stream_gen_moan_0 S_axi rego O3 ARO0000 718 - Qx4 AMOFFFF
== gth_axi_stream_gen_mon_1 S_axi rego OxdAL10000 [ZE18 - Qx4 AAMIFFFF
== microblaze_sub_swstemfmadm_1 S_Ax1 Reg O3 FE200000 718 - QO¥TE20FFFF
= microblaze_sub_systemfmicrablaze _0_axi_intc S_axi Reg 03 1200000 [ZE18 - Qx4 120FFFF
== mac_phy_chdften_gig_eth_mac_chQ S_axi Reg 037400000 718 - QxT4COFFFF
== mac_phy_chlften_gig_eth_mac_chl S_axi Reg OxF4C10000 718 - QxT4CIFFFF

P~ Instruction (22 address bits @ 40
L ea microblaze_sub_systemfmicroblaze_O_local_memaryfilmb_bram_if_cntlr  SLME Mem OxOODA0000 128K = QxO001FFFF

UG1058_c5_05_062314

Figure 4-5: Peripheral Address Map

For more details on the MicroBlaze processor core see the MicroBlaze Soft Processor Core
webpage [Ref 20].

For more details on AXI Interconnect see the AX/ Interconnect webpage [Ref 25].

AXI UART Lite

The AXI UART Lite IP core provides the controller interface for asynchronous serial data
transfer. The Ethernet Controller application running on the control computer
communicates with this serial interface.

The AXT UART Lite IP core also connects to the MicroBlaze processor subsystem through the
AXlinterface and passes information to and from the Ethernet Controller application to the
different components of the design.

For more details on the AXI UART Lite see LogiCORE IP AXI UART Lite Product Guide (PG142)
[Ref 18] and the AXI UART Lite webpage [Ref 25].

Eyescan System Components

The Eyescan System in this reference design is based on the application note XAPP1198.
Refer to 7 Series In-System Eye Scan of a PCl Express Link with Vivado IP Integrator and AXI4
(XAPP1198) [Ref 6] for more information.
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AXI DRP Bridge

The AXI DRP bridge receives AXI requests from an AXI master such as the MicroBlaze
processor subsystem. It converts AXI transactions to DRP registers accesses on the
transceiver and routes the result back to the AXI Master. One bridge is required for every
transceiver that performs an eye scan. This reference design has two instances of the AXI
DRP bridge to get eye scan plots on 10-Gigabit Ethernet Channel 0 and Channel 1.

There is also an AXI DRP MUX in the reference design. This allows multiplexing of DRP
accesses between the AXI DRP Bridge and the 10-Gigabit Ethernet PCS/PMA IP Core.

AXI Block RAM Controller

An AXI Slave IP core that allows access to local block RAM by AXI Master devices such as
MicroBlaze processor subsystem and JTAG to AXI Master IP core. The block RAM stores the
data read from the DRP port of the transceiver.

For more details on the AXI Block RAM controller IP see the AX/ Block Ram webpage [Ref 8]

JTAG to AXI Master

The JTAG to AXI Master IP core is a customizable core that can generate AXI transactions
and drive AXI signals internal to FPGA. The Vivado logic analyzer Tcl console running on the
control computer interacts with this core through the USB-to-JTAG port on the

KCU1250 board (Refer to Vivado Design Suite User Guide Programming and Debugging
(UG908) [Ref 8]). It retrieves data stored in AXI BRAM controller and passes it to the control
computer.

For more details on the JTAG to AXI Master IP core see the JTAG to AXI Master webpage
[Ref 9]

MicroBlaze Processor Subsystem

The MicroBlaze processor subsystem communicates to the transceiver DRP interface
through the AXI to DRP Bridge logic. The software running on the MicroBlaze processor is
derived from code described in Eye Scan with MicroBlaze Processor MCS (XAPP743) [Ref 10].
The software running on the processor implements the Eye Scan algorithm on the
transceiver and stores the data in the AXI block RAM. When the block RAM is filled with Eye
Scan data, the JTAG to AXI IP core reads the data out of the block RAM. Then it stores the
data on the control computer in a text file through the USB-JTAG connection (U80) on the
KCU1250 board.

For more details on the MicroBlaze processor core see the MicroBlaze Soft Processor Core
webpage.
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AXI Interconnect
The AXI interconnect allows multiple AXI masters (MicroBlaze processor subsystem and

JTAG to AXI Master) to communicate with multiple AXI slaves (AXI DRP Bridge and AXI
BRAM Controller). The address map for the AXI slaves is shown in Figure 4-6.

&= Diagram X B Address Editor X

Cell | Slave Interface | Base Mame | Offset Address | Range | High Address
= §-1iF jtag_axi_0
o2 | | & ER Data (32 address hits : 40)
'1‘?‘:1 e axi_bram_ctrl 0 A Memo Dy C 2000000 =18 > OHC2001FFF
» —m drp_bridge_0 A regQ Dy CO00Co00 L1 v QHCOO00FFF
e drp_bridge_1 A regQ QxCO001000 L1 » QuCOO01FFF

{F mb_psfmicroblaze_0
B Data (27 address bits @ 40)

e axi_bram_ctrl_0 A% Memo O C 2000000 =1 > QHC2001FFF
e drp_hridge_0 AX regQ O CO000000 4 » QxCOO0OFFF
—m drp_hridge_1 A regQ OxCO001000 E18 * QxCOO01FFF
e mb_ps/Iimb_bram_if_cntlr_0 SLME tem QxO0000000 16K » Ox00003FFF
B Instruction (22 address bits 40

L an mb_psfmb _taram_if_cotle_0 SLMEL M em (0000000 1ak > QHOOOO3IFFF

UG1058_c5_315_092414

Figure 4-6: AXI Slaves Address Map in the Eyescan System

For more details on the AXI Interconnect see the AXI Interconnect webpage.
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Clocking and Reset

The 10-Gigabit Ethernet PCS/PMA core requires a 156.25 MHz differential reference clock
for the GTH transceivers. The shared logic (clocking and reset logic) within the channel 0

10-Gigabit Ethernet PCS/PMA IP core produces a single ended 156.25 MHz clock. This clock
is used by the 10-Gigabit Ethernet MAC and Traffic generator on Channel 0. A similar clock
circuit is implemented for Channel 1. The MicroBlaze processor subsystem is driven by the
channel 0 156.25 MHz clock. The single ended 156.25 MHz clocks from both channels are
routed to the Eyescan System. Figure 4-7 shows the clock distribution.

156.25 MHz 156.25 MHz
Differential Clock Differential Clock

156.25 MHz CHO 156.25 MHz CHA1

Y \ \ \i A
MicroBlaze ) CH1
Subsytemand | [CHOTraffic |1 oo mac CHOPHY | | CH1 PHY CH1 MAC Traffic AXI
Gen-Mon UARTLITE
AXI Interconnect Gen-Mon

N A A A A A
a @ & & @ @
: g g 2 2 2
B |;' \;' Eyescan |;' |;' |;'
£ = = > System [« = ~ =
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Figure 4-7: Clock Distribution

An external reset (a debounced DIP switch) drives the channel 0 10-Gigabit Ethernet
PCS/PMAIP core, the 10-Gigabit Ethernet MAC IP core and the Processor System Reset IP
core in the processor system. This reset also drives the Eyescan System.

Another external reset dip switch drives the Channel 1 10-Gigabit Ethernet PCS/PMA IP
core, the 10-Gigabit Ethernet MAC IP core and the Traffic Generator and Monitor block.
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The Processor System Reset Module IP core provides resets for the MicroBlaze processor
subsystem components and resets to the AXI Interconnect and peripherals (AXI4-Lite
interfaces on AXI UART Lite, Traffic Generator and Monitor, and 10-Gigabit Ethernet MAC
IP). Figure 4-8 shows the reset connections.

reset_ch1_n
DIP Switch | | Debouncer | reset ch1
Reset Logic
Eyescan @ @ =
System Iy DY Iy
\9)‘ IE |9)‘
DIP Switch | | Debouncer | _reset ch0 o o 2
Reset Logic o o o
5 > =}
A A
CHO CH1
CHO CHO . CH1 CH1 )
Traffic Traffic
PHY MAC Gen-Mon PHY MAC Gen-Mon
@ & e @
L L L L
2 2 2 g
o e o e
=] > 35 =
|> reset_ chO_n |,
'>_<._
I
g
Reset to AXI4 Stream Interface
—— Reset to MAC and PHY peripheral_aresetn
Processor |;
Reset to AXI Lite Interfaces System interconnect_aresetn \: g |:
Reset |bus_struct_reset = = =
o sy ly
@ I I
mb_reset 4 & @
Y y Y 5 5 5
MicroBlaze M'Cl_r;’f;fze AXI | tAx' . AXI UART
Processor Interconnect nterrup Lite
memory Controller
A

UG1058_c5_07_092014

Figure 4-8: Resets
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Software

There are two major software components to monitor and control the Ethernet Reference
Design System:

» GUI/Client Application

« MicroBlaze Processor Server Application

Figure 4-9 shows these components.

GUI/Client Application Server Application

UART Interface

Control Computer Microblaze Processor on KCU1250 Board

UG1058_c5_08_101614

Figure 4-9: Software Components

GUI/Client Application

A Java-based GUI/Client application running on the control computer communicates with
the MicroBlaze Processor Server Application through a UART interface to control test
parameters, collect statistics and display current status of the design.

The GUI displays the following information:

« Current mode of operation

« Payload size

« Throughput numbers and graphs when a test is executing
» 10-Gigabit Ethernet MAC IP statistics

« Power consumption and temperature for the FPGA device

« Block diagram of the design
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Figure 4-10 shows the GUI
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Figure 4-10: GUI (Ethernet Controller Application)

The GUI provides control of:

« Test mode: Select use of the internal traffic generator to generate Ethernet traffic.
« Payload size: Specify the size of packets when running in internal generator mode.
The GUI interacts with the KCU1250 board through the UART COM port exposed by the

Silicon Labs UART driver. All transmitted and received data adheres to a custom command
model followed by the client and server.
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Command Format

The command format used by the GUI for reading and writing 32-bit values to the registers
in the design is described in this section.

Read Command

R <type of request> <output type> <Command number, denoted as a
4-character hexadecimal numeric string, AAAA>

« R denotes a Read command
« type of request indicates the type of request and it can either be:
- s which specifies a single register read request, or

- b which specifies a bulk read request

Use a single register read for debugging purposes or for reading registers which are not
monitored by the GUL

Use a bulk read command to make the GUI constantly poll all test parameters and statistics.
This eliminates the need to send multiple commands for each individual value. A bulk read
command reads the registers in a predefined order.

* output type indicates output type and it can be:
- h specifies the value sent out by the server will be the actual data width i.e., 4 bytes
o a specifies the value sent out by the server will be an 8-byte hexadecimal string

« AAAA denotes four character hexadecimal numeric string representation of the
command number which will eventually be mapped to the actual register offset in the
server application. Using different command numbers instead of the actual register
values allows the GUI to remain constant in spite of changes in the hardware design or
the application.

Example Read command:

R s a 0001: Read a single register corresponding to command number 0001 and the
reported value from the server should be in 8-byte hexadecimal format.

Read command response:

1. The command number is read by the server and the appropriate register is identified, its
value is read, and is stored in a 4-byte data value.

2. Based on the output type specified in the read command, the data is either directly
transmitted to the client by the server, or it is converted to an 8-character string
denoting an 8-character hexadecimal number and then sent out to the client on the
control computer side.
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Currently the application only supports output type of 8-character hexadecimal string.

An example Read command output response : FOO000O0F.
Write Command

W <Command Number denoted as a 4-character hexadecimal numeric string
AAAA> < Data, represented as an 8-character hexadecimal numeric
string DDDDDDDD>

« W denotes a Write command

« AAAA denotes a 4-character hexadecimal string representation of the command
number which will eventually be mapped to the actual register offset in the server
application.

« DDDDDDDD denotes an 8-character hexadecimal string.
Example Write command:

e W 0001 007D0002: Write a value of 007D0002 to the register corresponding to
command value 0001.

Write command is always targeted towards a single register.

The mapping of command numbers to the corresponding register values is the same for
both Read and Write commands, i.e., if a write command with a certain command number
is used to update a register value, the same command number can be used with a read
command to retrieve the value.
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MicroBlaze Processor Server Application

MicroBlaze Processor Server application running on the FPGA takes care of interpreting the
read and write commands sent from the client application, and acts accordingly. The software
layers are as shown in Figure 4-11.

Register Offset
Executer Identification for the Executer :
- ‘ 1
A 2
3
Form Response
and Send to Client on Host Side 4
5
Command [_A4 ‘ - A
Interpreter =
Command Number
A to Array Index Mapping 8
9
10
Y —
UART Driver Integer Array
Containing All
Register Offsets

UG1058_c5_10_062714

Figure 4-11: Software Layers in the MicroBlaze Processor Server application

When the hardware platform is exported to the Software Development Kit (SDK) as
described in Generate ELF file for the MicroBlaze Controller in mac_phy.bd, page 21:

« The drivers for standard peripherals (like UART, Interrupt controller, etc.) that are
connected to the MicroBlaze processor are already available in the SDK.

« The base address of each peripheral assigned in the hardware platform as shown in
Figure 4-5 and is also accessible by the SDK.

The register offsets required by the server application to access relevant registers (TRD
configuration registers, performance registers, MAC Statistics, etc.) are available in the
LogiCORE IP 10-Gigabit Ethernet MAC Product Guide (PG072) [Ref 17] and the user space
registers as described in Appendix C, User-Space Registers.

The UART driver is responsible for transferring and receiving data from the UART interface.
The server application uses the Application Programming Interface (API) provided by the
UART driver and communicates with the client application running on the control computer.
The main task of the server is to read/write values from/to the registers specified in the
READ/WRITE commands issued by the GUI.

The various steps undertaken by the server in servicing requests from the client are:
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1.

10.

11.

Register offsets to access registers are put in an integer array during the initialization of
MicroBlaze processor server application. The value placed in the integer array is:

- Base address for the component + register offset

The order in which these register offset values are placed is made aware to the client
application on the host side.

Each register is identified using a unique command number. This command number is
same for both read and write commands.

When a client initiates a Read/Write command, the data is obtained by the server
application through the UART driver.

The Command Interpreter part of the server application then interprets the data
obtained from UART.

The Command Interpreter identifies the register offset value in the integer array, with
respect to the command number associated with the request.

The Command Interpreter functionality is different for Single Read and Bulk Read
commands.

For a single read request, command number shall give the index of the integer array
where the referenced register offset is placed.

Example Single Read Command:
R s a 0001

Here the command number is translated to 1 and the offset value of the register being
requested is placed in the zero index of the array.

For a bulk read request the command number represents a set of registers with a clearly
defined start and end index positions in the array.

Example Bulk Read Command:
R b a 0001

Here the command number 1 represents a set of register offsets in the array, 2 to 17. The
values placed at these array indices are the Ethernet performance registers for Channel
0 and Channel 1.

The Executor part of the server application then initiates either AXI Read/Write request
to the register offset values identified.

The Executor then sends an appropriate response to the client on control computer
through the UART driver.
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NOTE: The bulk Read commands from GUI are serviced by the Server application by going through all

O the registers associated with the command in a predefined order and transferring the data with a '’
(white space) as delimiter between each register's value. This mode greatly reduces the number of
commands the GUI has to send to obtain the same amount of information.

The source code for the MicroBlaze application is available under the software/source
directory (see Appendix A, Directory Structure). The command mapping is defined in
CommandDesc. h.

NOTE: The software components for generating eye scans are described in XAPP743 [Ref 10] and
O XAPP1198 [Ref 6] and are not covered in this document.
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Appendix A

Directory Structure

The directory structures for the 10GBASE-KR TRD is shown in Figure A-1.

uc1250_10gbasekr_trd

software hardware ready_to_test readme
source sources
GUI hdl
ip_packaged
ip

constraints

testbench

vivado

scripts

UG1058_Aa_01_032515

Figure A-1: Targeted Reference Design Directory Structure
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Directory Content Summary

The files and folders contained in the 10GBASE-KR TRD are described inTable A-1. The
top-level folder is kcul250_10gbasekr_trd.

Table A-1: Directory Content

Folder Description
software Contains the software design deliverables.
source Contains the source code files used for creating the ELF file application that runs on the
MicroBlaze™ processor and communicates with the GUL
GUI Contains the EXE file used to install the Ethernet Controller GUL
hardware Contains all the required sources needed to generate a bitstream.
sources Contains subfolders that contain HDL files, custom IP that is packaged,
VIO IP files, constraint files, and testbench files.
hdl Contains HDL files.

ip_packaged | Contains custom IP that is packaged.

ip Contains VIO IP files.
constraints | Contains constraint files.
testbench Contains testbench files.
vivado Contains files to create a Vivado® Design Suite project and outputs of vivado runs.
scripts Contains Tcl scripts to create a Vivado project.
runs Created when the Tcl script file is sourced. The runs folder contains the output of simulation,
synthesis and implementation processes.
ready_to_test Contains the bit file to program the KCU1250 characterization board.
readme A TXT file that describes the 10GBASE-KR TRD and includes revision history information.
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Appendix B

Performance Estimates

The 10-Gigabit Ethernet MAC IP core operates at a clock rate of 156.25 MHz using a 64-bit
data-path width (64 x 156.25 x 10® = 10 Gb/s).

For the XGMII, the minimum required interframe gap is 12 bytes. Header overhead consists
of a preamble (7 bytes) + Start of frame delimiter (1 byte) + MAC destination address (6
bytes) + MAC source address (6 bytes) + Length/Type field (2 bytes) + FCS (4 bytes). This
gives a total overhead of 38 bytes per Ethernet packet.

Table B-1 shows the effective throughput and percentage of maximum bandwidth used for
four different payload sizes.

Table B-1: Effective Throughput as a Function of Payload

Ethernet Payload Size,| Percentage of Bandwidth = |Effective Throughput,
Bytes Payload size/Packet size * 100 Gb/s
64 64/(38 + 64) = 62.7% 6.27
512 512/(38 + 512) = 93.1% 9.31
1024 1024/(38 + 1024) = 96.3% 9.63
1500 1500/(38 + 1500) = 97.5% 9.75
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Appendix C

User-Space Registers

User-space registers are user defined registers implemented in the Traffic Generator and
Monitor block shown in Figure 4-1, page 37. These registers can be accessed by the
MicroBlaze™ processor subsystem via the AXI4-Lite interface.

Table C-1 through Table C-14 describe the custom registers implemented in the
10GBASE-KR TRD. All registers are 32 bits wide. Register bit positions are to be read from
bit 31 to bit 0 from left to right. All bits that are undefined in this section are reserved and
will return zero when read. Address holes will also return a value of zero when read.

Each peripheral connected to the MicroBlaze processor subsystem is assigned an offset
address which is the base address for that peripheral. Figure 4-5, page 45 shows the
addresses assigned to the Traffic Generator and Monitor blocks
(eth_axi_stream_gen_mon_0 and eth_axi_stream_gen_mon_1). The Traffic Generator and

Monitor base addresses are:

» Traffic Generator and Monitor channel 0: 0x4AA0_0000

« Traffic Generator and Monitor channel 1: 0x4221 0000

Control and Status Registers

Traffic Generator—Monitor Channel 0

Table C-1: Design Version Register (0x4AA0_0000)

Bit Position Mode Default Value Description
3:0 4'h2 Ethernet reference design 2.
Indicates the Vivado® Design Suite version used when
15:4 Read Only 12'h141 developing this reference design. For example, Vivado Design
Suite 2014.1 is indicated by 141.
31:16 16'h1250 | Target Board: KCU1250 board.
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Table C-2: Ethernet Performance Monitor, Transmit Payload Byte Count Register (0x4AA0_0004)
Bit Position Mode Default Value Description
1:0 00 Sample count. Increments once every second.
Transmit payload byte count. This field contains the interface
312 Read Only 0 utilization count for active beats (tx_axis_tready = 1 and
’ tx_axis_tvalid = 1) on channel 0 10G Ethernet MAC AXI4-Stream
interface for transmit.
Table C-3: Ethernet Performance Monitor, Transmit Packet Count Register (0x4AA0_0008)
Bit Position Mode Default Value Description
1:0 00 Sample count. Increments once every second.
Transmit packet count. This field contains the count for the
312 Read Only 0 event when there is an active beat on channel 0 10G Ethernet
’ MAC AXI4-Stream interface and end of packet (tx_axis_tlast) is
asserted for transmit.
Table C-4: Ethernet Performance Monitor, Received Payload Byte Count Register (0x4AA0_000C)
Bit Position Mode Default Value Description
1:0 00 Sample count. Increments once every second.
Receive payload byte count. This field contains the interface
312 Read Only 0 utilization count for active beats (rx_axis_tready = 1 and
’ rx_axis_tvalid = 1) on channel 0 10G Ethernet MAC AXI4-Stream
interface for receive.
Table C-5: Ethernet Performance Monitor, Received Packet Count Register (0x4AA0_0010)
Bit Position Mode Default Value Description
1:0 00 Sample count. Increments once every second.
Receive packet count. This field contains the count for the event
312 Read Only 0 when there is an active beat on channel 0 10G Ethernet MAC

AXI4-Stream interface and end of packet (rx_axis_tlast) is
asserted for receive.
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Table C-6: Traffic Generator Configuration Register (0x4AA0_0014)
Bit Position Mode Default Value Description
0 0 Reserved.
1 Read or Write 0 Enable generator if internal generator is selected.
31:16 41125 Ethernet frame data payload size. Allowed values (46 bytes to
1,500 bytes).
Table C-7: PHY status Register (0x4AA0_00x18)
Bit Position Mode Default Value Description
0 Read Only 0 PHY is up.
Traffic Generator—Monitor Channel 1
Table C-8: Design Version Register (0x4AA1_0000)
Bit Position Mode Default Value Description
4:0 4'h2 Ethernet reference design 2.
Software version: Indicates the Vivado® Design Suite version
14:5 Read Only 12'h141 used when developing this reference design. For example,
Vivado Design Suite 2014.1 is indicated by 141.
31:16 16'h1250 | Target Board. KCU1250 board.
Table C-9: Ethernet Performance Monitor, Transmit Payload Byte Count Register (0x4AA1_0004)
Bit Position Mode Default Value Description
1:0 00 Sample count. Increments once every second.
Transmit payload byte count. This field contains the interface
312 Read Only 0 utilization count for active beats (tx_axis_tready = 1 and
’ tx_axis_tvalid = 1) on channel 1 10G Ethernet MAC AXI4-Stream
interface for transmit.
Table C-10: Ethernet Performance Monitor, Transmit Packet Count Register (0x4AA1_0008)
Bit Position Mode Default Value Description
1:0 00 Sample count. Increments once every second.
Transmit packet count. This field contains the count for the
312 Read Only 0 event when there is an active beat on channel 1 10G Ethernet
’ MAC AXI4-Stream interface and end of packet (tx_axis_tlast) is
asserted for transmit.
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Table C-11: Ethernet Performance Monitor, Received Payload Byte Count Register (0x4AA1_000C)
Bit Position Mode Default Value Description
1.0 00 Sample count. Increments once every second.
Receive payload byte count. This field contains the interface
312 Read Only 0 utilization count for active beats (rx_axis_tready = 1 and
’ rx_axis_tvalid = 1) on channel 1 - 10G Ethernet MAC
AXI4-Stream interface for receive.
Table C-12: Ethernet Performance Monitor, Received Packet Count Register (0x4AA1_0010)
Bit Position Mode Default Value Description
1:0 00 Sample count. Increments once every second.
Receive packet count. This field contains the count for the event
31:2 Read Only 0 when there is an active beat on channel 1 10G Ethernet MAC
’ AXI4-Stream interface and end of packet (rx_axis_tlast) is
asserted for receive.
Table C-13: Traffic Generator Configuration Register (0x4AA1_0014)
Bit Position Mode Default Value Description
0 0 Reserved.
1 Read or Write 0 Enable generator if internal generator is selected.
3116 3125 Ethernet frame. Data payload size allowed values = 46 bytes to
1,500 bytes.
Table C-14: status Register (0x4AA1_00x18)
Bit Position Mode Default Value Description
0 Read Only 0 PHY is up.
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Appendix D

Additional Resources and Legal Notices

Xilinx Resources

For support resources such as Answers, Documentation, Downloads, and Forums, see Xilinx
Support.

For a glossary of technical terms used in Xilinx documentation, see the Xilinx Glossary.

Solution Centers

See the Xilinx Solution Centers for support on devices, software tools, and intellectual
property at all stages of the design cycle. Topics include design assistance, advisories, and
troubleshooting tips.

References

The most up-to-date information for this design is available on these websites:

KCU1250 Characterization Kit

KCU1250 Characterization Kit Documentation

KCU1250 Characterization Kit Answer Record (AR 63058)

These documents and sites provide supplemental material:

KCU1250 Characterization Kit.

Vivado Design Suite User Guide Release Notes, Installation, and Licensing (UG973)
Silicon Labs CP210x USB-to-UART Installation Guide (UG1033)
Tera Term Terminal Emulator Installation Guide (UG1036)

HW-CLK-101-SCLK2 SuperClock-2 Module User Guide (UG770)
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http://www.xilinx.com/support/answers/63058.html
http://www.xilinx.com/about/feedback.html?docType=User_Guides&docId=UG1058&Title=KCU1250%2010GBASE-KR%20Ethernet%20TRD%20User%20Guide&releaseVersion=2016.2&docPage=64
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6.

7.
8.
9.

10.
11.
12.
13.
14.
15.
16.
17.
18.
19.
20.
21.
22.
23.
24.

25

7 Series In-System Eye Scan of a PCl Express Link with Vivado IP Integrator and AXI4
(XAPP1198)

AXI Block Ram webpage

Vivado Design Suite User Guide: Programming and Debugging (UG908)

JTAG to AXI Master webpage

Eye Scan with MicroBlaze Processor MCS (XAPP743)

UltraScale Architecture GTH Transceivers User Guide (UG576)

10 Gigabit Ethernet PCS/PMA with FEC/Auto-Negotiation (10GBASE-KR) webpage
LogiCORE IP 10-Gigabit Ethernet PCS/PMA Product Guide (PG068)

Vivado Design Suite User Guide Logic Simulation (UG900)

Virtual Input/Output (VIO) webpage

LogiCORE IP Virtual Input/Output Product Guide for Vivado Design Suite (PG159)
LogiCORE IP 10-Gigabit Ethernet MAC Product Guide (PG072)

LogiCORE IP AXI UART Lite Product Guide (PG142)

10 Gigabit Ethernet Media Access Controller (10GEMAC) webpage

MicroBlaze Soft Processor Core webpage

AXI UART Lite webpage

UltraScale Architecture System Monitor (UG580)

LogiCORE IP AXI4-Lite IPIF Product Guide for Vivado Design Suite (PG155)
LogiCORE IP System Management Wizard Product Guide (PG185)

. AXI Interconnect webpage

These external websites provide supplemental material and information:

26.

27.

28.

29.

30.

IEEE Std 802.3-2012
IEEE Standard for Ethernet (includes specifications for 10GBASE-KR and 10GBASE-R)

Tyco Electronics
Z-Pack Tinman Customer System kit (backplane)

Avnet
Samtec BullsEye cables

Silicon Labs
CP210x USB to UART Bridge VCP Drivers

Oracle
Java SE Runtime Environment 7
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http://www.xilinx.com
http://www.xilinx.com/products/intellectual-property/DO-DI-10GEMAC.htm
http://www.xilinx.com/cgi-bin/docs/rdoc?v=latest;d=ug908-vivado-programming-debugging.pdf
http://www.te.com
http://www.xilinx.com/products/intellectual-property/EF-DI-10GBASE-KR.htm
http://www.xilinx.com/cgi-bin/docs/rdoc?v=current;d=ug900-vivado-logic-simulation.pdf
http://www.xilinx.com/products/intellectual-property/axi_uartlite.htm
http://www.xilinx.com/support/documentation/user_guides/ug580-ultrascale-sysmon.pdf
http://www.xilinx.com/cgi-bin/docs/ipdoc?c=axi_lite_ipif;v=latest;d=pg155-axi-lite-ipif.pdf
http://www.xilinx.com/cgi-bin/docs/ipdoc?c=axi_uartlite;v=latest;d=pg142-axi-uartlite.pdf
http://www.xilinx.com/cgi-bin/docs/ipdoc?c=system_management_wiz;v=latest;d=pg185-system-management-wiz.pdf
http://www.xilinx.com/tools/microblaze.htm
http://www.xilinx.com/support/documentation/application_notes/xapp1198-eye-scan.pdf
http://www.xilinx.com/products/intellectual-property/axi_interconnect.htm
http://www.xilinx.com/cgi-bin/docs/ipdoc?c=ten_gig_eth_mac;v=latest;d=pg072-ten-gig-eth-mac.pdf
http://www.xilinx.com/products/intellectual-property/vio.htm
http://standards.ieee.org/about/get/802/802.3.html
http://www.em.avnet.com/en-us/design/drc/Pages/Samtec-BullsEye-Cable-for-Xilinx-FPGA-Characterization-kits.aspx
http://www.silabs.com/products/mcu/pages/usbtouartbridgevcpdrivers.aspx
http://fedoraproject.org/
http://www.silabs.com/products/mcu/pages/usbtouartbridgevcpdrivers.aspx
http://www.oracle.com/technetwork/java/javase/downloads/java-se-jre-7-download-432155.html
http://www.xilinx.com/support/documentation/user_guides/ug576-ultrascale-gth-transceivers.pdf
http://www.xilinx.com/support/documentation/ip_documentation/vio/v3_0/pg159-vio.pdf
http://www.xilinx.com/cgi-bin/docs/ipdoc?c=ten_gig_eth_pcs_pma;v=latest;d=pg068-ten-gig-eth-pcs-pma.pdf
http://www.xilinx.com/products/intellectual-property/jtag_to_axi_master.htm
http://www.xilinx.com/support/documentation/application_notes/xapp743-eye-scan-mb-mcs.pdf
http://www.xilinx.com/products/intellectual-property/axi_bram_if_ctlr.htm
http://www.xilinx.com/about/feedback.html?docType=User_Guides&docId=UG1058&Title=KCU1250%2010GBASE-KR%20Ethernet%20TRD%20User%20Guide&releaseVersion=2016.2&docPage=65
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31. Tera Term Home Page
Tera Term Pro terminal emulator software

32. Aeroflex
SMA DC Block

Please Read: Important Legal Notices

The information disclosed to you hereunder (the “Materials”) is provided solely for the selection and use of Xilinx products. To the
maximum extent permitted by applicable law: (1) Materials are made available “"AS IS" and with all faults, Xilinx hereby DISCLAIMS
ALL WARRANTIES AND CONDITIONS, EXPRESS, IMPLIED, OR STATUTORY, INCLUDING BUT NOT LIMITED TO WARRANTIES OF
MERCHANTABILITY, NON-INFRINGEMENT, OR FITNESS FOR ANY PARTICULAR PURPOSE; and (2) Xilinx shall not be liable (whether
in contract or tort, including negligence, or under any other theory of liability) for any loss or damage of any kind or nature related
to, arising under, or in connection with, the Materials (including your use of the Materials), including for any direct, indirect,
special, incidental, or consequential loss or damage (including loss of data, profits, goodwill, or any type of loss or damage
suffered as a result of any action brought by a third party) even if such damage or loss was reasonably foreseeable or Xilinx had
been advised of the possibility of the same. Xilinx assumes no obligation to correct any errors contained in the Materials or to
notify you of updates to the Materials or to product specifications. You may not reproduce, modify, distribute, or publicly display
the Materials without prior written consent. Certain products are subject to the terms and conditions of Xilinx's limited warranty,
please refer to Xilinx's Terms of Sale which can be viewed at http://www.xilinx.com/legal.htm#tos; IP cores may be subject to
warranty and support terms contained in a license issued to you by Xilinx. Xilinx products are not designed or intended to be
fail-safe or for use in any application requiring fail-safe performance; you assume sole risk and liability for use of Xilinx products
in such critical applications, please refer to Xilinx's Terms of Sale which can be viewed at http://www.xilinx.com/legal.htm#tos.

Automotive Applications Disclaimer

XILINX PRODUCTS ARE NOT DESIGNED ORINTENDED TO BE FAIL-SAFE, OR FOR USE IN ANY APPLICATION REQUIRING FAIL-SAFE
PERFORMANCE, SUCH AS APPLICATIONS RELATED TO: (I) THE DEPLOYMENT OF AIRBAGS, (II) CONTROL OF A VEHICLE, UNLESS
THERE IS A FAIL-SAFE OR REDUNDANCY FEATURE (WHICH DOES NOT INCLUDE USE OF SOFTWARE IN THE XILINX DEVICE TO
IMPLEMENT THE REDUNDANCY) AND A WARNING SIGNAL UPON FAILURE TO THE OPERATOR, OR (III) USES THAT COULD LEAD
TO DEATH OR PERSONAL INJURY. CUSTOMER ASSUMES THE SOLE RISK AND LIABILITY OF ANY USE OF XILINX PRODUCTS IN
SUCH APPLICATIONS.

This document contains preliminary information and is subject to change without notice. Information provided herein relates to
products and/or services not yet available for sale, and provided solely for information purposes and are not intended, or to be
construed, as an offer for sale or an attempted commercialization of the products and/or services referred to herein.

© Copyright 2014-2016 Xilinx, Inc. Xilinx, the Xilinx logo, Artix, ISE, Kintex, Spartan, Virtex, Vivado, Zynq, and other designated
brands included herein are trademarks of Xilinx in the United States and other countries. All other trademarks are the property of
their respective owners.
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http://www.xilinx.com
http://ttssh2.sourceforge.jp/index.html.en
http://www.aeroflex.com/AMS/inmet/pdfiles/8037.pdf

http://www.xilinx.com/legal.htm#tos
http://www.xilinx.com/legal.htm#tos
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